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About this Manual 

This manual has been written for laboratory technicians and provides 
detailed instructions for using the DSX™ Automated ELISA System.  

This manual gives you the information needed to: 

• Install the DSX™ 

• Set up the DSX™ to suit your specific application requirements 

• Understand the DSX™ menus 

• Run assays using the DSX™ 

• Create or modify assays 

• Perform required preventive maintenance 

• Service the DSX™ 

• Review safety precautions 
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Chapter 1  Overview 

Introduction 

The DSX™ Automated ELISA System (Figure 1) is a computer-controlled 
microplate processing system that fully automates ELISA assays. The DSX 
System automates the sample distribution, incubation, reagent addition, 
washing and detection phases of microplate assays. It is intended for use in 
clinical, research and industrial laboratories.  

The DSX is an automated system that is useful for medium throughput, 
multiple assay applications. The system is designed to process specimens 
in a continuous flow from sample to result. Operator attendance is normally 
not required once a run has started.  

Samples 

A run can contain up to 96 samples. Serum and/or plasma specimens are 
generally used for clinical testing, although other fluids such as urine or 
spinal fluid can be run. Specimens containing large particulate matter, such 
as stool, tissue homogenates or culture media, can also be used. It is 
recommended that these specimens are processed through a mesh filter 
prior to loading onto the system to assure sample homogeneity and 
pipetting precision.  

A wide variety of standards or control samples can also be run. Standards 
or controls are loaded onto a separate rack that contains up to 33 
standard/control tubes. The tubes are available from your supplier. 

 

Figure 1. The DSX™ Automated ELISA System 
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Reagents 

The DSX System utilizes a single reagent rack that contains up to 24 
bottles. The required reagent bottles are available from your supplier. 

Pipetting  

Pipetting of samples, standards/controls and reagents is performed using 
custom-designed disposable pipette tips to assure pipetting precision and 
eliminate possible cross-contamination.  Reagent tips pipette from 25 µL to  
1 mL of reagents, and sample tips pipette from 5 µL to 300 µL of samples 
or standards/controls. 

Dilutions 

The DSX System will perform single-stage or multi-stage dilutions of 
sample. Dilutions ranging from 1:2 to 1:40,000 can be performed, using 
deep-well dilution plates on the system for dilutions above 1:60.  

Incubation 

Up to four temperature-controlled plate incubators may be present. Each 
incubator can be set at a temperature ranging from ambient plus 7 °C to  
50 °C, and each plate can be shaken during incubation. The particular 
incubator modules that are used during a worklist, the temperature of each 
incubator, and the shake parameters are automatically set by the system 
when the worklist is created.  

Washing 

Eight wells in one column of a 96-well plate can be washed simultaneously. 
Washing protocols can be defined so that all of the columns are washed in 
the same manner, or different wash cycles can be applied to specified 
columns on a plate. 

A wide variety of user-defined wash protocols can be programmed on the 
system. In addition, different plate types can be accommodated. 

Detection 

During operation, each microplate is automatically transferred to the 
absorbance module at the appropriate time. The optical densities of the 
wells specified during assay definition are read, the various calculations (for 
example, blanking, QC of raw data, threshold or curve fitting) are applied, 
and the calculated results for the microplate are reported.  
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Features 
The DSX™ Automated ELISA System has a number of performance and 
convenience features. These are summarized below: 

• Different assays can be run on the same plate 

• ESP™ (Electronic Signature Pipetting) for liquid level and clot 
detection 

• Endpoint data analysis to perform qualitative and quantitative data 
reduction 

• Less than 10 second reading time (using single wavelength) 

• On-board self diagnostics 

• Selection of up to six filters 

• Single, dual and multiple wavelength reading modes 

• Easily removable incubator, wash, and absorbance modules for 
servicing 

• Small footprint 

• A variety of wash protocols can be programmed 

• A variety of plate types can be programmed 

• Liquid level sensing on Waste Container and Wash Buffer 
Containers 

• Quick dispense 

• Aspirating/pipetting speed can be changed for viscous liquids 
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Chapter 2  Description 

Hardware Components 
Locations of the principal hardware components of the DSX™ Automated 
ELISA System are shown in Figure 2. 

Indicator Light 

The system contains an indicator light (Figure 3) that is illuminated 
whenever the system power is ON. 

!  CAUTION: Power is on to the system and to the 
incubator heaters whenever the indicator light is 
illuminated. A thermal hazard is present. 

 

Figure 2. Location of Principal Hardware Components  

     Wash Buffer/            Pipette      Work       System     Absorbance  Wash      Incubator  
Dispense Containers    Module      Area         Cover        Module      Module      Modules 

Ambient 
Drawer 

Liquid Waste 
Container 

Waste Tip 
Container 
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System Cover 

The system cover encloses the workspace and pipette module. The cover 
must be closed during operation to prevent the pipette module from 
accidentally contacting an operator or bystander. An electrical interlock 
prevents operation of the pipette module when the system cover is open. 

! CAUTION: The electrical interlock for the system 
cover prevents accidental contact with the pipette 
module and/or robotic arm. Never disable the 
interlock unless instructed to do so by DYNEX 
personnel. 

To open the cover, lift the handle until the cover is in the upright position 
(Figure 3). The cover will remain in this position until it is closed.  

To close the cover, push down on the handle until the cover is fully closed 
and locked. The system cover rests on the cover stop when it is fully 
closed.  

! CAUTION: Pinching hazard. Be sure that your hands 
and fingers are clear of the cover stop when closing 
the system cover. 
 

 

Figure 3. System Cover 

 Handle                  System Cover 

Cover 
Stop 

Indicator 
Light 
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Workspace 

Samples, reagents, standards and controls, and consumables are loaded 
onto the workspace. Their locations are shown in Figure 4. 

Sample tubes are contained in seven sample racks. Each sample rack 
contains 14 tubes and, although up to 98 samples can be contained on the 
system at one time, 96 sample tubes are used in routine operation. The 
seven sample racks are contained in a sample caddy. Since different 
sample tubes can be used on the system, the user must specify the sample 
tube dimensions before the tubes can be used. 

Standards or controls are contained in the control rack, which contains up 
to 33 standard/control tubes. A specific 1.5-mL tube is required for 
standards or controls. The tubes can be obtained from your supplier. 

Sample tips used for pipetting samples and standards/controls are 
contained in four sample tip racks. Each rack contains 108 sample tips, 
and a total of 432 sample tips can be loaded on the system. A specific 
sample tip is required and can be obtained from your supplier.  

Reagent tips used for pipetting reagents are contained in a reagent tip 
rack that contains 41 reagent tips. A specific reagent tip is required and can 
be obtained from your supplier.  

 

Figure 4. The Workspace 

 Sample     Dilution     Reagent     Reagent     Tip Waste  
  Racks        Plate          Rack       Tip Rack       Chute           

Sample 
Tip Racks 

 
 
 

Reagent 
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Dilution 
Plate  

 
Control 
Rack 



Hardware Components  

8 DSX™ System Operator’s Manual 

Reagent bottles are contained on the reagent rack, which contains up to  
24 reagent bottles.  A specific 25-mL reagent bottle is required and can be 
obtained from your supplier.  

Two deep-well dilution plates can also be loaded. The dilution plates are 
used for two-stage (external) dilutions ranging from 22:1 to 1:36,100.   

After a sample tip or reagent tip has been used, the pipette module moves 
over the tip waste chute and releases the tip. The tip waste chute directs 
the used sample tip or reagent tip into the waste container. 
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Ambient Drawer 

The ambient drawer is used to store microplates when room temperature 
incubation in the dark is required.  The ambient drawer will extend into the 
work area during pipetting. 

When setting up a worklist, the plate carrier is extended from the ambient 
drawer (Figure 5), plate holders (see the following page) are placed in 
each of the ambient drawer positions, and the required microplates are 
placed onto the plate holders.     

! The microplate positions are numbered from 1 to 4. 
Refer to page 59 for a summary of the procedure to 
prepare a worklist. 

 

 

Figure 5. The Ambient Drawer 

Position 1          Position 2          Position 3        Position 4 
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Plate Holders 

Plate holders (Figure 6) allow the pipette module to transfer a microplate 
between modules.  

Each plate holder has a pickup feature which the pipette module uses to 
transfer a microplate.  

! Whenever this manual refers to a microplate, it is 
implied that the microplate is seated in a plate holder . 

 

 

Figure 6. Plate Holder 

Gripping                          Positioning         
   Slot                                   Pins         
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Pipette Module 

The pipette module is used to transfer microplates, to pipette samples, 
controls and standards, dispense reagents, and to perform dilutions. The 
pipette module travels in the x-, y- and z- directions to access the samples, 
controls, reagents, microplates and consumables on the workspace. The 
pipette module is shown in Figure 7. 

The pipette module has the following functions: 

 Function Purpose   
    
 Microplate 

Handling 
The microplate handler transfers a microplate 
between the ambient drawer, an incubator module, 
the wash module and the absorbance module by 
gripping the microplate holder, moving it to its new 
location, and releasing it. 

 

 Pipetting 
(automatic 
liquid level 
sensor) 

The pipettor pipettes samples or standards/controls 
using disposable sample pipette tips. Dispenses 
reagents using disposable reagent pipette tips. 
Each pipette tip is automatically discarded into the 
waste bin after use. A new pipette tip is obtained 
from a sample tip rack or the reagent tip rack when 
it is needed.   

 

 Tip Ejection 
Detection 

Verifies that a used tip was ejected before obtaining 
a new tip. 

 

 

 

Figure 7. The Pipette Module 

Pipette Module 
 
 

Microplate 
Holder Clamp 

and Tip Ejector 
 
 
 

Pipettor 
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Separate pipetting profiles ranging from 1 to 5 can be specified for any 
fluid except wash buffer. The pipetting profile specifies the rate at which 
fluids are aspirated or dispensed from the pipette tip. 

The pipetting system of the DSX™ Automated ELISA System includes 
ESP™ (Electronic Signature Pipetting) software for automatic detection of 
clots, foam, or bubbles when pipetting samples. The pipeting signature 
observed when pipetting each sample is compared to nominal pipetting 
signatures of particular sample types (for example, serum or plasma) 
obtained during system configuration. If the pipetting signature does not fall 
within the normal range of pipetting profiles for that sample type, the system 
records an error.   

! CAUTION: Changing the pipette profile can affect 
accuracy and precision of an assay.  

 

! The default pipetting profile is 4. The pipetting profile 
used for samples is specified during definition of 
worklist runtime parameters. Refer to page 61 for a 
summary. The pipetting profiles used for standards 
and controls are specified during definition of assay 
operations. Refer to page 29 for a summary.  

! The pipetting signature is specified during definition of 
worklist runtime parameters. Refer to page 61 for a 
summary 

Sample Mixing During Dilution 

The user can program up to 9 dispense/aspirate mix cycles during dilution 
steps to achieve optimal mixing of samples during dilution.  
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Pre-Dilution 

The DSX™ Automated ELISA System can perform a pre-dilution of 
samples before they are assayed.  Pre-dilution can be performed in a single 
stage in standard microplates or in two stages using deep-well microplates. 
The system can be programmed to add diluent to a plate before or after the 
sample is added. 

The dilution modes are described below: 

 Dilution Mode Description  
    
 Microplate 

Dilution 
Ratios of sample to diluent range from 11:1 to 
1:59 (e.g. 5 µL sample combined with 295 µL of 
diluent to yield a 1:59 dilution.  

 

 Deep-well Plate 
Dilution 

Ratios of sample to diluent range from 2:1 to 
1:190 (e.g. 5 µL sample combined with 950 µL 
of diluent to yield a 1:190 dilution.  

 

 Deep-well Plate 
plus Microplate 
Dilution 

Ratios of sample to diluent range from 22:1 to 
1:11,210 (e.g. 5 µL sample combined with  
950 µL of diluent in a deep-well to form a new 
sample from which 5 µL is combined with  
295 µL of diluent in a microplate to yield a 
1:11,210 dilution.  

 

 Deep-well Plate 
plus Deep-well 
Plate Dilution 

Ratios of sample to diluent range from 4:1 to 
1:36,100 (e.g. 5 µL sample combined with  
950 µL of diluent in a deep-well to form a new 
sample from which 5 µL is combined with  
950 µL of diluent in another deep-well to yield a 
1:36,100 dilution.  
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Incubator Modules 

Microplates are incubated and shaken in the incubator modules. A 
maximum of four incubator modules are present, so that different 
microplates can be incubated at different temperatures with or without 
shaking. Incubation temperature and shake duration are specified during 
definition of an assay. 

! Note: Refer to page 29 for a summary of the 
procedures to define an assay. A microplate can also 
be incubated at ambient temperature without shaking 
by allowing it to remain in the ambient drawer for a 
specified period of time. 

The particular incubator modules that are used during a worklist and the 
temperature and shaking of each incubator are automatically set by the 
system when the worklist is created. Processing of the worklist will not 
commence until the temperature of each required incubator module is at the 
correct value.   

! Note: The incubator modules are labelled as 1, 2, 3 
and 4 and are designated as such in the Revelation™ 
software. The incubator modules will control 
microplate temperature at any specified temperature 
ranging from ambient plus 7 °C to 50 °C. 

 

Figure 8. Incubator Modules 

Incubator 
Modules 

Ambient 
Drawer 

3 

4 

2 

1 
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Wash Module 

The well contents of a microplate are washed in the wash module  
(Figure 9). The wash module is designed to wash all 8 wells in one column 
of an 8 x 12 microplate simultaneously. The washing protocol can be 
defined to wash partially filled plates containing complete columns. 

Different user-defined wash protocols can be contained on the system. In 
addition, the system can be configured with different plate types so that the 
wash head positions for each plate type can be specified. The system can 
accommodate flat-bottom, C-bottom, U-bottom and V-bottom types of 
microplates. 
 

! Note: Refer to page 29 for a summary of the wash 
protocol alternatives. 

Wash Head 

The wash head contains two sets of wash pins. The shorter pins (the 
dispense pins) dispense fluid and the longer pins (the aspirate pins) 
aspirate fluid.  The aspirate pins and the dispense pins are closely spaced 
so that fluid can be aspirated from and dispensed into wells at the same 
time.  

The wash pins are fixed to the wash head. During operation, the wash head 
assembly is lowered to insert the wash pins into the wells or raised to 
remove the wash pins from the wells. Lowering the wash head assembly 
allows the well contents to be aspirated or a bottom wash to be performed. 
Raising the wash head assembly allows the wash head to be moved so 
another column can be washed or so the wells can be filled. 

 

Figure 9. Wash Module  

Plate                Wash     Dispense/Aspirate      
Drawer             Head            Pins 
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Wash Head Positions 

The vertical positions that the wash head can assume (Figure 10) are 
described below. Each wash head position can be specified by the user to 
within 0.1 mm. 

! Note: Wash head positions for various plate types are 
specified during consumables management. See 
page 28 for additional information. 

   Wash Head Position Description   
    
 Dispense Height Defines the position at which fluid will be 

dispensed. While it is often desirable to set 
this height just above the top of the well in 
order to form a positive meniscus, the user 
should ensure that an overflow does not 
occur.  

 

 Top of Well Positions the aspiration pins so they are 
aligned with the top of the well. At this 
position, the liquid meniscus is removed 
from the top of the well.  

 

 Aspiration Height Positions the aspiration pins at the bottom 
of the well so that the contents of the well 
can be completely aspirated.  

 

 Sweep Height Raises the aspiration pins slightly above 
the Aspiration Height (see above) so that 
the aspiration pins can be moved back and 
forth in the well while the fluid is being 
aspirated without the danger of scratching 
the bottom of the plate.  

 

 Bottom Wash Height Lowers the wash head to this height during 
dispense so that the force of the 
dispensed fluid can wash the bottom of the 
wells.  

 

 Sweep Stroke Defines the horizontal motion used during 
a sweep operation to fully aspirate well 
contents.  

 

! Note: Select No Sweep for sweep mode and disable 
bottom washing whenever a C-bottom, U-bottom or 
V-bottom plate is being used. 
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Figure 10. Position of the Wash Pins 

 

Wash Protocol Operations 

A wash protocol consists of a series of Purge, Move, Soak, Aspirate, 
Dispense and Fill operations. Purge, Move and Soak can be carried out in 
any sequence. Aspirate, Dispense and Fill can only be carried out within a 
Move operation, and there cannot be a Move within a Move.  

Each of these operations is summarized below: 

 Operation Description   
    
 Purge Dispenses fluid from the dispense wash pins while 

the wash head is positioned over the purge tray. A 
purge is usually carried out at the beginning of a 
wash protocol or at the end of the day to rinse the 
dispense wash pins and remove air bubbles. 

 

 Move Performs Aspirate, Dispense, Fill and/or Soak 
operations on specified strips of the Microplate. 

 

 Aspirate Removes the contents of a well by positioning the 
wash pins at the aspiration height in the well and  
aspirating the liquid from the wells. 

A sweep may also be performed during Aspirate. 

 

 Dispense Dispenses a specified amount of fluid into the wells 
after aspirating the contents of the wells. If a 
bottom wash is specified, the wash head is then 
lowered to the bottom wash position so that fluid 
will be aspirated from the bottom of the wells while 
fluid is being dispensed.  

 

 Soak The contents of the wells are allowed to equilibrate 
for the specified number of seconds. 

 

 Fill The wells are filled with a specified amount of fluid.  

   

Aspirate 

Dispense 

Microplate 
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Wash Head Sweep Modes 

Sweep modes specify whether the aspiration tip moves from side-to-side 
during aspiration. Five sweep modes can be used:   

• No sweep 
• Always sweep 
• Sweep on last cycle only 
• Always Super Sweep 
• Super sweep last cycle only 

! Note: Select No Sweep for sweep mode and disable 
bottom washing whenever a C-bottom, U-bottom or 
V-bottom plate is being used. 

Plate Drawer  

The plate drawer holds the microplate in a known position so that the wash 
pins are precisely positioned in the wells during various wash protocol 
operations. The plate drawer allows linear shaking of the plate. 

Wash Buffer Containers  

Up to four different washing and/or dispensing reagents are contained on 
the system in wash buffer containers. The wash buffer containers are 
located at the front of the instrument (Figure 11).  

Each container contains up to two liters of wash buffer. Dispensing of wash 
buffer from a container is controlled by a submersible pump in the wash 
container, a dispense valve above the wash bottle, and a dispense valve 
located near the wash head. The specified wash buffer is dispensed into 
wells whenever a Dispense or Fill operation is specified in the wash 
protocol. 

Each wash buffer container must contain at least 500 mL of wash buffer in 
order to be used.  

!  Note: The particular wash buffer that is used and the 
Dispense, Fill or Purge operations are defined during 
assay definition. See page 57 for a summary of the 
procedures for assay definition. 

A quick connect fitting and a level sensor/pump connector allow easy 
removal of a wash buffer container from the system (Figure 12). Disconnect 
the wash line by pressing on the metal tab of the quick connect fitting and 
gently pulling up on the wash line to remove it. Disconnect the level sensor 
and pump connector by pulling it out of the connector socket.  

Fill (or empty) a wash buffer container using the filler cap at the rear of the 
container.   
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Figure 11. Wash Buffer Containers and Wash Buffer Dispense Valves 
 
 

 

 
Figure 12.  Wash Buffer Container Details 

Wash Buffer     Wash Buffer    Wash Buffer     Wash Buffer 
Container A      Container B     Container C      Container D 

Dispense     Dispense    Dispense     Dispense 
 Valve A       Valve B      Valve C      Valve D 

Quick Connect 
Fitting 

Level Sensor and 
Pump Connector 

Filler Cap 
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Waste Containers  

Fluid that is removed during purging and washing is collected in the liquid 
waste container. Used sample and reagent pipette tips are disposed into 
the tip waste container. Both waste containers are located at the front of 
the instrument (Figure 13). 

 

 

 

Figure 13. Waste Containers 

The liquid waste container (Figure 14) holds up to eight liters of waste. A 
level sensor alerts the operator when the liquid waste container is full. 

Two quick connect fittings connect the liquid waste and vacuum lines to 
the liquid waste container. Disconnect each fitting by pressing on the metal 
tab of the quick connect fitting and gently pulling on the line to remove it.  

Disconnect the level sensor connector by pulling it out of the connector 
socket.  

Empty the liquid waste container by removing  the waste cap at the front of 
the container. 

! Note: Be sure that the waste cap is securely 
tightened. Otherwise, a vacuum leak will cause the 
software to create a vacuum error condition. 

! Note: 10% (v/v) solution of household bleach in water 
is recommended as a disinfectant. 

  Tip Waste                                    Liquid Waste 
   Container                                      Container  
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Figure 14.  Liquid Waste Container 

 

  Level Sensor         Manifold           Vacuum          Waste 
     Connector          Connector       Connector          Cap  
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Absorbance Module 

The absorbance module measures the optical density (OD) of the final 
reaction mixture in the microplate wells. The wavelength mode that is used 
and the wavelength(s) at which the optical density is measured are 
specified during assay definition.  

! Note: Procedures for specifying the wavelength mode 
and the wavelength(s) at which the optical density is 
measured are defined during assay definition. See 
page 57 for a summary of the procedures for assay 
definition. 

! Note: The current version of Revelation™ software 
supports endpoint reactions. 

During operation, each microplate is automatically transferred to the 
absorbance module at the appropriate time. The optical densities of the 
wells specified during assay definition are read, the various calculations (for 
example, Blanking, QC Raw Data, Threshold or Curve Fitting) are applied, 
and the calculated results for the microplate are reported.  

! Note: Procedures for specifying the manner in which 
assay results are calculated and reported are defined 
during assay definition. See page 57 for a summary 
of the procedures for assay definition. 

The location of the absorbance module is shown in Figure 15. 

 

Figure 15. Absorbance Module 

 

Absorbance 
Module 

Ambient 
Drawer 
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Optical Path 

The optical path through the Absorbance module is shown in Figure 16.  A 
tungsten halogen lamp projects a light beam through a heat absorbing filter 
and a lens. The beam is focused by the lens and passes through a filter 
(located on the filter wheel), which allows only light of the desired 
wavelength range to pass.  The beam is then separated into 13 channels, 
one of which is used as a reference channel to monitor the light output of 
the lamp. The other 12 beams are directed upwards through a row of 12 
wells on the microplate, onto an array of silicon photodiodes. The silicon 
photodiodes quantify the intensity of light transmitted through the reaction 
solution.  Absorbance of the solution is measured in terms of optical density 
(OD) and the assay results are interpreted accordingly. 

 

 
1 Lamp 6 Lenses 
2 Heat Filter 7 Optic Stops 
3 Lens 8 Microplate 
4 Filter 9 Photodiodes 
5 Optic Fibers 10 Reference Diode 
 

Figure 16. Optical Path of the Absorbance module 

7 
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Single and Dual Wavelength Modes 

The Reader is able to take readings in three different modes: 

• Single--using one test wavelength 

• Dual--using one reference wavelength and one test wavelength  

• Multiple--using a combination of wavelengths 

The Single wavelength mode is sufficient for most applications.  

The Dual wavelength mode can be used if it is necessary to reduce errors 
caused by dirt and scratches on the bottom of the wells.  

The choice of test and reference wavelengths for the Dual Wavelength 
mode depends on the particular enzyme/substrate system being tested. 
However, the following rules should usually be followed: 

1. The test wavelength (λt) should be at or near the maximum 
absorbance of the reaction product. 

2. The reference wavelength (λr) should lie outside the 
absorbance band of the system but not far removed. 

 

Figure 17. Dual Wavelength Selection 

405 nm                             λt                         λr           690 nm  

       FILTER WAVELENGTH 



 Hardware Components 

DSX™ System Operator’s Manual 25 

The Reader subtracts the absorbance at the reference wavelength (λr) from 
the absorbance at the test wavelength (λt) to minimize the effect of 
systematic errors. 

If a test requires particular precision, you may specify test and reference 
filters of the same wavelength. The Reader will average the ODs produced 
using each filter, giving a more precise result. 

Multiple Wavelength Mode 

The Multiple wavelength mode reads samples at two different wavelengths 
and is used to obtain results where the peak absorbance is outside the 
optical range of the Reader.  

The first reading (or the Primary mode) is at or near the peak wavelength. A 
second reading (or the Secondary mode) of the sample is then obtained at 
a wavelength that is within the absorbance region but not at the peak.  

The Reader automatically uses the Primary mode reading when it 
calculates results. If, however, the absorbance in the Primary mode 
exceeds the detection limit of the Reader, the Secondary mode reading is 
used.  

If the Secondary mode reading is used, the peak absorbance is calculated 
from the secondary mode reading using an algorithm that is selected by the 
user during configuration of the system. 

Blanking 

The Reader lets you subtract a reference value from all the ODs.  It 
automatically uses air as a reference, but for certain applications other 
reference levels may be more appropriate. 

For example, you may want to eliminate the absorbance of a reagent 
solution from the test result.  The Reader can hold the OD of this reagent 
solution in memory and subtract it from all subsequently read ODs. 

Blanks may be single wells, or an average of wells. 



Software  

26 DSX™ System Operator’s Manual 

Software 
Revelation™ software is used to control the DSX microplate processing 
system. The software automates the sample distribution, incubation, 
reagent addition, washing and detection phases of microplate assays. It 
also provides the user interface for configuration of the instrument and 
management of consumables (Figure 18). 

The software includes an extensive menu of assay definition options that 
allow you to customize the readings, calculations, QC checks and results 
format for an assay. 

Additional information about the software can be found in the DSX Online 
Operator’s Manual, accessed by selecting the Help menu.  

Consumab les
Management

Assay Def in i t ion

Workl is t  Execut ion

Data Analys is

Resul ts  Report ing

Data Veri f icat ion

DSX Conf igurat ion

Workl is t  Creat ion

 

Figure 18.  Revelation™ Software Overview 
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DSX Configuration 

The DSX System can be configured for particular uses in your laboratory. 
Refer to Chapter 4 (Preparing the System for Use) for instructions. 

The configuration options are summarized below: 

 Option Description   
    
 Configure Reader Define COM port, filters, conversion limits, 

maintenance scripts, and log file processing. 
 

 Select Fonts Select the font to be used for printed results 
reports.  

 

 Set Options Create short-cut buttons. 

Set default plate processing options, including 
auto save and auto print. 

Select the colors for different well types. 

Set default directories. 

Enter the laboratory name and address to be 
printed on results reports.  

 

 Assign a System 
Password 

Change the default password in Revelation™ 
software. 
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Consumables Management 

A database of all consumables and fluids is maintained in the software. 
Once a consumable or fluid is defined in the database, it can be selected 
from a drop-down list during definition of an assay.  

Consumables and fluids are defined using the Tools menu. The fluids and  
consumables that are defined and the information that is entered for each 
are summarized below: 

 Consumable Information Entered  
    
 Washer Fluids Define the fluids that are used for washing and 

purging. 
 

 Sample Tubes Define sample tubes and their specific 
dimensions. 

 

 Reagent/Diluent 
Fluids 

Define reagents and diluents, and specify 
whether they are time-sensitive. If they are, 
specify the maximum on-system use time. 
Specify the pipette profile used when aspirating 
and dispensing a reagent or diluent. The profile 
should be set to 4 unless otherwise required.   

 

 Standard/ 
Control Fluids 

Define standards and controls, and specify 
whether they are time-sensitive. If they are, 
specify the maximum on-system use time. 
Specify the pipette profile used when aspirating 
and dispensing a standard or control.  

 

 Washer Plates Specify the height of the washer head for 
various washing positions (for example, well top 
height, dispense height and wash height) for 
each type of microplate that is used. 
Specify sweep modes that can be used during 
washing and their parameters. 
Specify whether bottom washing can be used 
during washing. 
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Assay Definition 

The reagents, standards and controls that are used and the dilution, wash 
and incubation procedures for an assay are specified during assay 
definition. These options are defined using the Operations menu.  

Arrangement of well types on the microplate, reading options, and 
procedures to be used for calculations, QC checks and reporting when 
running a test are also specified during assay definition. These options are 
defined using the Data Reduction menu.  

The assay definition options are summarized below: 

 Option Purpose   
    
Operations Menu:   

 Pipette Samples/ 
Standards/ 
Controls 

Specify plate templates. 
Specify sample, standard or control volumes. 
Specify pipetting techniques and tip usage. 
Specify dilutions. 

 

 Dispense Fluid Specify reagent volumes.  

 Wash Plate Specify plate types, wash methods and wash 
buffer volumes. 
Specify details for the Purge and Clean cycles. 
Specify details for the Soak and Shake options. 

 

 Incubate Plate Specify incubation time, temperature and 
shaking. 

 

    
Data Reduction Menu:  

 Data Reduction 
Wizard 

Displays the Data Reduction dialog boxes in 
the order they appear on the menu, starting 
with Assay Title. 

 

 Assay Title Specify assay title, author, code and password.   

 Reader Control Specify assay wavelength(s), wavelength mode 
and shake.   

 

 Template Specify the use (sample, control, blank, etc.) of 
each well on the plate, including the number of 
replicates, orientation, and fill direction.  

 

 Blank Mode Select a pre-defined blank mode or define a 
custom blank mode.  
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 Option (Cont’d) Purpose   

    
Data Reduction Menu:  

 QC Raw Data Define a quality control equation to be applied 
to the raw data obtained when running the 
assay. 

 

 Threshold Define threshold equations, positive/negative 
Q.C. ranges, threshold Q.C. equations, and the 
results output format.  

 

 Curve Fit Specify the parameters required to obtain 
quantitative results with a user-defined curve fit.  

 

 Ratio Define the equation and output format required 
to report results as a ratio. 

 

 Spreadsheet Perform arithmetic calculations on ODs from 
different wells. The results of these calculations 
are output as a matrix or table of data.  

 

 Report Options Select report formats, matrix type, and export 
files.  

 

 Assay Options Specify area statistics, processing order, and 
sample ID setup.  
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Worklist Creation 

A worklist specifies the samples that are to be run. A worklist can include 
up to four microplates and multiple assays. More than one assay can be run 
on a plate if the assays have the same incubation, washing and shaking 
specifications. 

! Note: An assay must be created before it can be 
assigned to samples on a worklist. 

! Note: The procedure for creating a worklist is 
summarized on page 59.  

Worklist Execution 

Once a worklist has been created, the run can be started. The system 
prompts the operator to load any microplates and consumables that are 
required by the worklist. 

! Note: The procedure for running a worklist is 
summarized on page 61.  

Data Analysis 

The optical density results for each well on each of the microplates in the 
worklist are analyzed according to the criteria that were specified during 
assay definition. 

Results Reporting 

When the processing of a microplate is completed, the results of the run are 
displayed on the screen.  

Results files are automatically named xxx.dat, where xxx is the name you 
selected for the plate. Results are stored in the Plate Data directory.   

! Note: Select the Options command on the Tools 
menu to view or change a directory in which results 
files or other files are located.  

Data Backup 

Revelation™ software allows the user to save all assays and worklists on 
floppy diskettes to avoid loss of data. 
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Required But Not Provided 

Computer 

A personal computer with monitor, keyboard, mouse and printer is required 
for operation of the DSX™ Automated ELISA System.  

The computer system provides the means for you to enter information and 
obtain results. The computer stores and retrieves assay profiles, executes 
the defined worklist, and performs the various calculations needed for the 
assay. 

The computer system that is used for operation of the DSX™ Automated 
ELISA System must meet the following minimum requirements: 

• Pentium microprocessor running at 500 MHz or better. 

• Hard disk with at least 100 MB of free space. 

• Microsoft® Windows® NT operating system. 

• VGA graphics card (Super VGA recommended). Monochrome, 
CGA, EGA or calibrated monitors are not supported.  

• The Display properties should be set to a desktop area of at least 
600 x 800 pixels and a color palette of at least 256 colors.   

• At least 64 megabytes (MB) of random-access memory (RAM).  
(128 MB RAM is recommended). 

• One unused RS232 serial port is required for connecting the 
computer to the DSX™ Automated ELISA System. 

• Mouse or other pointing device supported by Windows. 

• Any printer that is supported by Windows® NT can be used.  

• Compatible sound card 
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Specifications 

Dimensions and Weight 

Depth  <91 cm (35.8 in) 

Width  <106 cm (41.8) 

Height  <80 cm (31.5 in) 

Weight   <110 Kg (243 lbs) 

Footprint 106 cm x 91 cm (41.8 in x 35.8 in) 

Capacities 

Samples 96 

Reagents 24 

Controls and/or Standards 33 

Sample Pipetting Tips 432 

Reagent Pipetting Tips 41 

Wash Buffer Bottles 4 bottles, 2 liters each  

Waste Container 8 liters  

Operation 

Ambient Drawer Module 
Incubation Temperatures 

 Ambient plus 5 °C  

Incubator  Module 
Incubation Temperatures 

 Ambient plus 7 °C to 50 °C 

Assays  

Blanking Air 

Individual, paired or average wells 

Whole plate or last plate 

Row or column 

Each well on the plate 

Wavelength Modes Single, dual or multiple 

Standard Curves Linear, quadratic, cubic, quartic, spline, polygon, 
sigmoid or Akima 

Additional Data Analysis Threshold, ratio, QC equations 

Flexible Template Up to eight different well types. 
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Power Requirements 

 Voltage Power Frequency 

Main Unit 100 - 240 V 800 VA 50/60 Hz 

Line Voltage Variation ± 10% 

Line Frequency Variation ± 3 Hz 

Environmental 

Operating Range 15° C to 30° C 
15% to 85% relative humidity (non-condensing) 
2000 Meters Altitude 

Computer Interface 

Ports RS232 serial port  

Baud Rate 19200. Character format. 

Character Format 7 data bits, 1 stop bit, no parity 

Standards 

The instrument is designed in accordance with CSA 1010-1, CSA 1010-2-010,  
UL 3101-1, EN 61010-1, EN 61010-2-010 and EN 61326-1.  
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Warning Labels 

The DSX™ Automated ELISA System or its components may contain 
certain labels that that either warn the user of a hazard or note an electrical 
connection. A hazard is something that can cause personal injury to the 
operator or damage to the instrument. The labels that may be used on the 
DSX™ Automated ELISA System are described below.  

 

 Label Description   
    
 

 

 
Alternating current is present. 

 

    
 

 
(English) Caution symbol. Refer to the 
Routine Maintenance chapter. 

(French) Attention (voir documents 
d’accompagnement). 

 

    
 

 
(English) Caution, motion hazard. 

(French) Attention  

 

    
 

 

(English) Caution, pinching or mechanical hazard. 

(French) Attention 

 

    
 

 

(English) Caution, hot surface. 

(French) Attention, surface chaude. 

 

    
 

 

 
Protective conductor terminal. 

 

     
 

 

 
Earth (ground) terminal. 

 

    
 

 
(English) Caution, risk of electric shock. 

(French) Attention, risque de choc électrique. 

 

    
 

 

Caution, biohazard. 
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Chapter 3  Installation 

! IMPORTANT: These installation procedures are 
intended for trained personnel.   

Unpacking 

Materials Provided 

Article Quantity 

DSX™ Automated ELISA System 1 

Instrument Power Cable 1 

RS232 Communication Cable 1 

Cleaning Wire 1 

CD Containing Revelation™ Software Setup 
Program and Electronic Operator’s Manual 

1 

Shipping Check List 1 

Wash Buffer Containers 4 

Liquid Waste Container 1 

Reagent Rack 1 

Tip Waste Container 1 

Computer and Monitor (optional) 1 

Consumables Sample Kit 1 

Plastic Tweezers 1 

Needle Nosed Pliers 1 

3 mm Allen Wrench 1 

4 mm Allen Wrench 1 



Positioning the Instrument 

38 DSX™ System Operator’s Manual 

To unpack the components: 

1. Unpack the contents of the carton.  

! CAUTION: The contents are heavy (approximately 
110 Kg or 240 lbs) .  
  

2. Place the DSX™ Automated ELISA instrument in the 
approximate position where it will be located. 

3. Examine the packaging to be sure that the power cord, the 
computer connector cord and other materials have been 
removed.  Please save packaging material for future use. 

4. Check to verify that all of the materials listed on the previous 
page have been unpacked. 

5. Inspect the components for damage. If damage is observed, 
contact your shipper or service representative immediately. 

Positioning the Instrument 
Determine the area where the system will be located. You will need an area 
that is approximately 106 cm (41.8 inches) wide, 91 cm (35.8 inches) deep, 
and 80 cm (31.5 inches) high for the DSX™ Automated ELISA System.  

The system should be positioned on a level surface that does not support 
other devices that produce vibration (centrifuges, shaker bath, etc.). There 
must be at least 20 cm (7.9 inches) of space at the rear of the instrument to 
allow for sufficient ventilation.  
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Connecting the Computer System 

! Note: A computer system is required but not 
provided.  

To connect the computer system: 

1. Place the computer, keyboard, monitor and printer next to the 
DSX System. 

2. Plug the RS232 communication cable into an unused RS232 
port on the computer. Note the computer port (i.e., COM1 or 
COM2) that is used.  

! Note: Refer to the instructions accompanying the 
computer for the location of the ports and for 
information on connecting components.  

3. Plug the other end of the RS232 communication cable into the 
bottom RS232 port at the right side of the instrument (Figure 19). 

! Note:  The lowest of the 3 RS232 ports must be 
used. The other RS232 ports are used for diagnostic 
purposes. See Figure 19.  

4. Connect the keyboard, monitor and printer to the computer.  

5. Connect the power to the computer, monitor and printer.  

  

 

Figure 19. View of the Right Side of the DSX™ Automated ELISA System 

Cooling                         Power             Power Cord 
  Fan                             Switch              Connector 

RS232 Ports 
for Diagnostic 

Purposes 

RS232 Port 
for 

Connectio
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Connecting to a LIMS 
The RS232C port is bi-directional when used in computer control mode.  
The DSR/DTR handshake signals as well as software handshake are used 
to maintain communication status and synchronization.  

To Establish Computer Control Mode for the Reader 

 Computer Reader 

1. DSR asserted  

2. STX COMMAND ARGUMENTS 
checksum ETX.  Sends 
command character string. 

 

3.  ACK/NAK Indicates 
proper/improper reception 

4.  Executes task 

5.  ENQ Asks if computer is 
ready to receive answer 

6. ACK/NAK Indicates ready/not 
ready to receive 

 

7.  STX RESULTS/ANSWER 
checksum EXT Sends 
answer 

8. ACK/NAK Indicates 
proper/improper reception 

 

! Note: Steps 2 to 8 are repeated for subsequent 
transmissions provided the data link remains 
connected.  Results may require more than a single 
transmission, in which case Step 5 through Step 8 
must be repeated.  If the computer does not 
acknowledge receipt of data (NAK) in either Step 6 or 
in Step 8, the DSX will return to Step 5 and re-
transmit the results. 
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Checksum 

The DSX Reader is equipped with a Fletcher’s checksum algorithm to 
protect against any communication problems. 

The checksum is calculated as follows: 

sum 1 = 0 
sum 2 = 0 
for i from 1 to message length do 
   sum 1 = (sum 1 + message {i}) modulo 255 
   sum 2 = (sum 2 + sum 1) modulo 255 
end for 
checksum = sum 2*255 + sum 1 

This checksum is transmitted as a 4 digit hexadecimal (base 16) number in 
ASCII format. 

Example: 

Normal command STX 5 0 ETX 

character ASCII code sum 1 sum 2 

STX 2 0 0 
‘5’ 53 55 57 
‘0’ 48 103 160 

 
Checksum = 160 x 255 + 103 = 40903 
       = 9FC716 

The command therefore becomes: STX 5 0 9 F C 7 ETX 
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Loading Revelation™ Software 
Revelation™ software is provided on a CD ROM.  Before installing the 
software on the personal computer, you will need the following information: 

• The installation drive. Usually, this will be d.  

• The installation directory.   

To install Revelation Software: 

1. Start Microsoft Windows NT. 

2. Insert the installation CD ROM. 

3. Select Start and then Run from the task bar. 

4. Type d:\setup in the Run text box. 

5. Click OK. The setup program will start and the Revelation™ 
Installation Window will be displayed. 

! Note: To stop the installation, click on Exit. 

6. The prompt Setup is complete is displayed when the installation 
has been completed. Click on OK and remove the installation  
CD ROM. 

7. The Revelation™ program group is accessed from the Programs 
section of the Start task bar. 

! Note: The Revelation™ program icon can be added 
to your Windows NT desktop using the Settings 
section of the Start task bar.  

! Or, a Revelation™ shortcut icon can be placed on 
your computer desktop for convenient access to 
Revelation™. See the following section for 
instructions. 
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Creating a Shortcut Icon 

A Revelation™ shortcut icon can be placed on your computer desktop in 
two ways: 

• (Recommended) A shortcut program is created during installation. 
This program can be dragged to the desktop from Windows 
Explorer.  

• A new shortcut can be created. 

to use the installed shortcut: 

1. Open Microsoft Windows Explorer. 

2. Locate the Revelation™ shortcut in the directory 
c:\Windows\Start Menu\Programs\Revelation. 

3. Drag the Revelation™ shortcut icon to the desktop. 

! Note: Be sure to drag the Revelation™ shortcut, not 
the Revelation™ Help shortcut. 

4. Close Microsoft Windows Explorer. 
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Connecting the DSX Power Cord 
The power cord connection to the DSX is made at the right side of the 
system. 

! Note: Depending upon local electrical codes and 
electrical service quality, an optional uninterruptible 
power supply (UPS) may be required in your 
laboratory. The use of a UPS is optional but 
recommended.  

! CAUTION: The DSX System must be connected to 
properly grounded electrical outlets. Obtain 
assistance from a qualified electrician to verify that 
your electrical outlets are properly grounded. 
 
Before connecting the power cable, be sure that the 
components have been connected to each other as 
outlined in the previous section. 

To connect the power cord: 

1. Connect the power cord to the connector at the right side of the 
instrument (Figure 19).  

2. Connect the other end of the power cord to the laboratory 
electrical supply outlet.  
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Starting the System 

To start the system: 

! CAUTION: Before starting the system, be sure that all 
racks are properly seated and that the lids are 
removed from all tubes, plates and sample tip racks. 

1. Turn the DSX System power switch (Figure 19) ON.  

2. Turn the power ON (if necessary) for the computer, monitor and 
printer. 

3. Double-click the Revelation™ shortcut icon. Or, select 
Revelation from the Program menu in Windows NT. 

4. A startup dialog box is displayed listing startup choices  
(Figure 20). 

5. Select Connect to DSX to operate the DSX System.  

Or, select Configure Hardware to display the Setup DSX dialog 
box for configuring the system (see page 48). 

! Note: Select Connect in Demo Mode to run the 
sofware in demonstration mode. The DSX System is 
not connected during demonstration mode. Select 
Quit Revelation to exit from the Startup dialog box.  

 
Figure 20. Startup Dialog Box 
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Self Tests 
A series of self-tests are carried out after Connect to DSX is selected  from 
the Startup dialog box. The test results are displayed upon completion of 
the tests (Figure 21). 

The self-test results should be printed on a monthly basis so that a record 
can be kept of the performance of the DSX System. You can save test 
results (the test results files are named *.tst) and then open them for review 
or printout at a later date.  

! NOTE: The self-test results should indicate whether 
the system is operating properly. If a self-test failure 
is reported in the Self-Test window, it is 
recommended that you call Technical Service. 

To print self-test results: 

1. Select Print from the File menu while the self test results are 
displayed.  

! NOTE: If the DSX data files have been corrupted, the 
DSX prompts for the serial number. This can be found 
on the DSX rear panel.  

 

 

Figure 21.  Display of Self-Test Results 
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Chapter 4  Preparing the System for Use 

Configuring the Reader 
Configuring the reader allows the user to define the COM port, specify the 
filters that are installed and specify conversion limits, specify maintenance 
scripts, and specify a log file. 

To configure the reader: 

1. Select Configure Reader from the Tools menu. The Reader 
Type dialog box is displayed (Figure 22). 

2. Select Setup. The Setup DSX dialog box is displayed  
(Figure 23). 

! NOTE: The Setup DSX dialog box can also be 
displayed by selecting Configure Hardware from the 
Startup dialog box (Figure 20).  

3. Specify the settings for each of the Reader configuration options.  

! NOTE: Detailed instructions for an operation are 
contained in the DSX Online Operator’s Manual, 
accessed by selecting the Help button on the dialog 
box that is being used.  

 

 

 

Figure 22.  Reader Type Dialog Box 
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Figure 23.  Setup DSX Dialog Box 

 



 Editing Washer Plate Settings 

DSX™ System Operator’s Manual 49 

Editing Washer Plate Settings 
The wash head on the DSX must be aligned so that the tips of the wash 
pins are aligned with the base of the washer when the wash module is in 
Standby.  

To edit the washer plate settings: 

1. Obtain a microplate of the type for which the washer is to be 
aligned. 

2. Eject the washer plate carrier and carefully place the microplate 
in the carrier. 

3. Retract the plate carrier. 

4. Select Edit Washer Plates… from the Tools menu. The Edit 
Washer Plate Settings dialog box is displayed (Figure 24). 

5. Click New and enter a name for the type of plate for which the 
wash settings are being entered.  

Or: If settings for a plate that is already defined are being edited, 
select the plate from the Plates Currently Defined panel.  

6. Click the Show button opposite the Dispense Height field to 
position the wash head in the dispense height position.  

! Note: Refer to page 16 for a description of the various 
wash height positions. 

7. If the dispense height needs to be changed, enter the new value 
in the Dispense Height  field.  

8. Click the Show button opposite the Dispense Height field to 
position the wash head in the new dispense height position.  

9. Repeat Steps 7 and 8 until the dispense height is correct. 
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Figure 24. Edit Washer Plate Settings Dialog Box 

10. Repeat Steps 6 through 9 for each of the other wash height 
positions. 

11. Select the sweep mode and the sweep stroke. 

! Important: Select No Sweep for sweep mode and 
disable bottom washing whenever a C-bottom,  
U-bottom or V-bottom plate is being used. 

12. If sweep mode is enabled, specify the sweep stroke. 

13. Click on Close to save the entered values. 

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box that is being used.  
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Selecting the Results Font 
The user can select the font that is used when results reports are printed. 

To select the results font: 

1. Select Results Font from the Tools menu. The Font dialog box 
is displayed (Figure 25). 

2. Select the results font.  

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box that is being used.  

 

Figure 25.  Font Dialog Box 
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Setting Options 
Options allow the user to create assay short-cut buttons, set default plate 
processing options (including auto save and auto print), select colors for 
different well types, set default directories and enter the laboratory name, 
address and phone number(s) to be printed on results reports. 

To set options: 

1. Select Options from the Tools menu. The Options dialog box is 
displayed (Figure 26). 

2. Specify the settings for each of the Options tabs.  

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box that is being used.  

 

Figure 26.  Options Dialog Box 
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Changing the Password 
The system password can be changed. 

To change the system password: 

1. Select System Password from the Tools menu. The System 
Password dialog box is displayed (Figure 27). 

2. Specify a new system password. 

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box.  

 

Figure 27.  System Password Dialog Box 
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Specifying Consumables 
A database of all consumables and fluids is maintained in the software. 
Once a consumable or fluid is defined in the database, it is available for 
selection from a drop-down list during definition of an assay.  

To enter information for a consumable: 

1. Select the appropriate command (i.e., Edit Washer Fluids…) 
from the Tools menu. The corresponding dialog box is 
displayed. 

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box.  

2. Reagent bottles, Sample tips and Reagent tips are all pre-
defined in the Revelation™ software.  Refer to Reagents and 
Pipetting in Chapter 1 Overview for the ordering information. 
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Filling the Wash Buffer Containers 
The Wash Buffer Containers must be filled with the appropriate wash buffer 
and the dispense tubing and dispense pump power cable must be 
connected to the front of the instrument.  

To fill the Wash Buffer Containers: 

1. Disconnect a Wash Buffer Container (see page 18) and remove 
it from the system. 

2. Remove the rear cover of the Wash Buffer Container  
(Figure 12) and fill it with the wash solution that is to be used.  

! Note: The Wash Buffer Containers each contain up to 
two liters. 

3. Make sure that the dispense tubing is routed through the 
appropriate pinch valve at the front of the instrument.  

4. Connect the dispense tubing to the Wash Buffer Container and 
connect the Wash Buffer cable to the connector at the front of 
the instrument (refer to Figure 12 for details). 

! Note: Be sure that the wash tubing is not pinched or 
crimped. 

5. Repeat Steps 1 through 4 for the remaining wash buffer 
containers.   
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Connecting the Waste Container 
The Waste Container must be connected to the front of the instrument.  

To connect the Waste Container: 

1. Route the waste tubing through the routing holes inside the front 
panel of the instrument.  

2. Connect the vacuum tubing and the waste tubing to the 
connectors at the front of the instrument. 

! Note: The connectors for the vacuum tubing and the 
waste tubing are a different size so they cannot be 
reversed. 

! Note: Be sure that the waste tubing and the vacuum 
tubing are not pinched or crimped. 

3. Connect the level sensor cable to the connector at the front of 
the instrument. 
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Chapter 5 Defining an Assay 

Creating a New Assay 
The assay(s) for a worklist must be created before a worklist can be 
prepared. Assay operations (pipetting, dispensing, washing and 
incubating) and data reduction steps (see page 29) are specified in the 
assay.   

To create a new assay: 

1. Select New then Assay from the File menu. A default assay is 
displayed.  

2. Define the assay operations and data reduction steps as 
outlined below. 

To define assay operations: 

1. Display the default assay (see above). 

2. Select the desired assay operation from the Operations menu. 
The appropriate dialog box is displayed.  

3. Define the operation.  

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box that is being used.  

To define data reduction steps: 

1. Display the default assay (see above). 

2. Select the desired data reduction step from the Data Reduction 
menu. The appropriate dialog box is displayed.  

3. Define the data reduction step.  

! NOTE: Detailed instructions are contained in the DSX 
Online Operator’s Manual, accessed by selecting the 
Help button on the dialog box that is being used.  
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Modifying an Assay 
An assay can be modified at any time.  

To modify an assay: 

1. Select Open from the File menu. The Open dialog box is 
displayed (Figure 28).  

2. Select the assay to be modified. 

3. Modify the assay operations and/or data reduction steps as 
outlined on the previous page. 

 

 

Figure 28.  Open Dialog Box 
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Chapter 6  Creating a Worklist 

Creating a New Worklist 
A worklist specifies the assay(s) to be run on a series of samples. Once at 
least one assay exists, a worklist can be created.  

! NOTE: The worklist can include up to four 
microplates.  
 

Only one worklist can be open at a time.  
 

More than one assay can be run on one plate if the 
assays have the same incubation, washing and 
shaking specifications.  

To create a new worklist: 

1. Select New then Worklist from the File menu. The Edit Worklist 
dialog box (Figure 29) is displayed.  

2. Define the worklist. Detailed instructions are contained in the 
DSX Online Operator’s Manual, accessed by selecting Online 
Manual from the Help menu. 

 

Figure 29.  Edit Worklist Dialog Box 
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Modifying a Worklist 
An worklist can be modified at any time. However, only one worklist can be 
open at a time. 

To modify a worklist: 

1. Select Edit from the File menu. The Open dialog box is 
displayed (Figure 28).  

2. Select worklist (*wor.) as the file type.  

3. Select the worklist to be modified. 

4. Modify the worklist as outlined on the previous page. 
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Chapter 7  Running a Worklist 

Preparation 
Prepare for a run by setting the runtime options, emptying the waste 
container and filling wash buffer bottles with wash buffer (if required).  

To set runtime options: 

1. Display the worklist to be run (if needed) 

2. Select Runtime Options from the Timeline menu. The Runtime 
Options dialog box (Figure 30) is displayed. 

3. Define the runtime options. Detailed instructions are contained in 
the DSX Online Operator’s Manual, accessed by selecting 
Online Manual from the Help menu. 

 

 

Figure 30. Runtime Options Dialog Box 

Blue 

White 
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To empty the Waste Container: 

1. Disconnect the Waste Container (see page 20) and remove it 
from the system. 

2. Remove the cover of the Waste Container and discard the waste 
in accordance with local regulations. 

3. Rinse the waste container with DEIONIZED water. Discard the 
rinse water.  

!  Note: If desired, the waste container can be 
disinfected with a 10% (v/v) solution of household 
bleach in water, or 70% ethanol. If bleach is used, the 
container must be thoroughly rinsed with deionized 
water before replacing, as residual bleach may affect 
the results of ELISA assays.   

4. Replace and tighten the waste cap. 

! Note: Be sure that the waste cap is securely 
tightened. Otherwise, a vacuum leak will cause the 
software to create a vacuum error condition. 

5. Place the Waste Container on the system and re-connect the  
fittings. 

 

To fill a wash buffer bottle: 

1. Disconnect the Wash Buffer Container (see page 18) and 
remove it from the system. 

2. Remove the rear cover of the Wash Buffer Container  
(Figure 12). Lay the cover on a clean paper towel. 

3. Fill the wash buffer bottle with the wash buffer that is to be used.  

! Note: If the wash buffer in a bottle is being changed, 
discard the contents of the bottle and thoroughly 
clean it before filling it with the new wash buffer.  

4. Replace the cover and tighten it. 

5. Place the Wash Buffer Container on the system and re-connect 
the fittings. 
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Starting the Run 

To start the run: 

1. Display the worklist to be run (if needed) 

2. Select Start from the Timeline menu. A prompt to load the first 
microplate is displayed (Figure 30). 

3. Place the first microplate on the plate drawer in the position 
shown. 

4. Enter the plate ID (or read the plate barcode). 

5. Click OK. The next prompt is displayed. 

6. Follow additional instructions, making sure to load each item at 
the designated position. After an item is loaded and information 
(if any) is entered, click OK to display the next prompt.  

! Important: All racks are mounted on dowel pins. Be 
sure that each rack is securely seated and cannot 
move in either the x- or y- direction.  

7. Detailed instructions are contained in the DSX Online Operator’s 
Manual, accessed by selecting Online Manual from the Help 
menu. 

 

 

Figure 31. Load Plate prompt 
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Monitoring Run Status 

To monitor status of the run: 

1. Display the worklist (if needed). 

2. Select Worklist, Timeline, Consumables or Plate Layout from 
the Timeline menu. The corresponding view of the run is 
displayed (Figure 32). 

3. Detailed instructions are contained in the DSX Online Operator’s 
Manual, accessed by selecting Online Manual from the Help 
menu. 

 
Figure 32. Timeline View 
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Chapter 8  Service and Maintenance 

Routine Maintenance Procedures 

The following periodic maintenance procedures are required for the  
DSX™ Automated ELISA System: 

Daily maintenance: 

• Verify that the self-test passes. 

! Note: Results of the self-test can be printed if desired. 
Refer to page 46 for specifying printing of self-test 
results. 

• Empty and clean the Waste Tip Container. 

! Warning: While the DSX alone does not present a 
biohazard, the samples that are used and all parts 
and consumables in contact with the samples must 
be considered biohazardous. 

•  (As needed) Empty and clean the Liquid Waste Container. 

! Note: If desired, the Waste Tip Container and the 
Liquid Waste Container can be disinfected with a 10% 
(v/v) solution of household bleach in water, or 70% 
ethanol. If bleach is used, the containers must be 
thoroughly rinsed with deionized water before 
replacing, as residual bleach fumes may affect the 
results of ELISA assays.   

• Clean all plate drawers and external surfaces, using a towel 
moistened with 70% alcohol. 

• Purge the washer with 50mL of deionized water.  

! Note: The deionized water used for purging should be 
placed in Wash Buffer Container D (see Figure 11).   
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Weekly maintenance: 

• Empty the Wash Buffer Containers and clean them with several 
rinses of deionized water. 

• Remove and clean the waste tip chute. 

! Note: If desired, the waste tip chute can be 
disinfected with 70% alcohol or by autoclaving it. 
Bleach should not be used since it will corrode the 
metal.   

Six month maintenance: 

• Replace the dispense tubing.  

• Replace the aspiration tubing.  

! Note: The dispense tubing and aspiration tubing may 
need to be replaced more frequently than every six 
months, depending upon the frequency of use and 
the severity of operating conditions. 
 
Contact DYNEX for information on replacement 
tubing. 



 Cleaning and Decontamination 

DSX™ System Operator’s Manual 67 

Cleaning and Decontamination 

The DSX™ Automated ELISA System is constructed from materials that 
resist chemical attack.  

Spills should be cleaned as soon as possible. If you need to decontaminate 
the DSX™ Automated ELISA System instrument (for example, before 
servicing the instrument), clean the system and then decontaminate it as 
described below. 

! CAUTION: Always disconnect the power cable before 
cleaning the instrument.  

To clean the system: 

1. Clean external surfaces with a cloth moistened with mild 
laboratory detergent. 

! Note: If needed, dilute the laboratory detergent 
according to the manufacturer’s instructions before 
using.  

To decontaminate the system: 

1. Wipe the surfaces with a cloth moistened with a 10% (v/v) 
solution of household bleach in water or a 70% (v/v) solution of 
alcohol. 

! Note: Remove residual bleach from surfaces with a 
cloth moistened with deionized water. Residual 
bleach may affect the results of ELISA assays.   
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Removing a Module  

The incubator modules, absorbance module and the wash module can be 
easily removed from the DSX™ Automated ELISA System.  

To remove an incubator module or the absorbance module: 

1. Loosen the fasteners (Figure 33) one-fourth (¼) of a turn using a 
4 mm Allen wrench. 

! Note: The incubator modules and the absorbance 
module each have two fasteners.  

2. Pull the module out of the housing. 

3. Replace the module by reversing the procedure. 

 

 

Figure 33. Fasteners on the Incubator Modules or Detection Module 

To remove the wash module: 

1. Remove the wash head by loosening the thumb screw. 

2. Disconnect the tubing from the dispense valve on the washer 
module. 

3. Loosen the fasteners one-fourth (¼) of a turn using a 4 mm Allen 
wrench. 

! Note: The wash module has four fasteners.  

4. Pull the module out of the housing. 

4. Replace the module by reversing the procedure. 

Fasteners 
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Replacing the Absorbance Module Lamp  

! CAUTION: The optics assembly may be hot. Allow at 
least five minutes for the instrument to cool before 
opening the optics assembly. 
 
Also, be careful when removing the filter access panel 
as there is a possibility that the bulb may have 
broken. 
 
Failure to follow the lamp replacement procedures as 
described may result in personal injury.     

 

! CAUTION: Always disconnect the power before 
removing the filter access panel.  

To replace a lamp: 

1. Remove the absorbance module from the system. 

2. Remove the filter access panel to expose the optical assembly. 
The bulb is mounted in the upper portion of the optical assembly 
as shown in Figure 34. 

 

 

Figure 34. Optical Assembly 

Lamp 
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3. Put on a pair of rubber or latex gloves. 

! CAUTION: Gloves are necessary to prevent skin oils 
from damaging the lamp.  Gloves are also worn as a 
safety precaution should the glass bulb accidentally 
break.  

4. Grasp the lamp with plastic tweezers and pull the lamp out of its 
receptacle (Figure 35).  

! IMPORTANT: Use a gloved finger to prevent the bulb 
from bumping into the metal sidewalls of the 
enclosure during removal.  

5. Obtain a replacement lamp. 

6. Grasp the lamp tines with plastic tweezers and align the tines 
with the corresponding holes in the lamp socket. 

7. Firmly insert the lamp into the socket. 

8. Replace the filter access panel. 

9. Replace the absorbance module. 

 

Figure 35. Removing the Lamp 
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Replacing an Absorbance Module Filter 

! CAUTION: The optics assembly may be hot. Allow at 
least five minutes for the instrument to cool before 
opening the optics assembly. 
 
Also, be careful when removing the filter access panel 
as there is a possibility that the bulb may have 
broken.     

 

! CAUTION: Always disconnect the power before 
removing the filter access panel.  

To remove a filter: 

1. Remove the absorbance module from the system. 

2. Remove the filter access panel. The filters are mounted on the 
filter wheel as shown in Figure 34. 

3. Locate the filter that is to be removed. 

4. Firmly grasp the exterior filter housing with a pair of needle nose 
pliers (Figure 36).  

5. Pull the filter out of the spring loaded slot.  

6. Replace the filter access panel. 

 
Figure 36. Removing a Filter 
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To install a filter: 

1. Remove the filter access panel. The filters are mounted on the 
filter wheel as shown in Figure 34. 

2. Locate the filter position in which the filter will be installed.  

! IMPORTANT: Filters must be installed in adjacent 
filter positions, in the order of their wavelength. There 
must not be any empty filter positions between the 
lowest wavelength and highest wavelength filters.  

! Note: If a new filter is installed in a previously empty 
position or if the wavelength is being changed, the 
wavelength of the new filter must be entered. See 
page 47 for details.  

3. Firmly grasp the exterior filter housing with a pair of needle nose 
pliers. 

4. Push the filter into the spring loaded slot. 

5. Replace the filter access panel. 

! IMPORTANT: The bottom groove of the filter must be 
firmly seated in the filter wheel.  If the groove is 
aligned with the spring on the filter wheel then the 
filter has been installed incorrectly and will result in 
invalid instrument performance.  

6. Replace the absorbance module. 
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Replacing the Tubing  

To replace the tubing: 

1. Lift the rear edge of the metal panel at the front of the system 
(Figure 37) to expose the tubing. 

! Note: The metal panel is hinged at the front. When 
lifting the front panel, prevent it from dropping all the 
way forward.  

 

Figure 37. Lifting the Front Panel 

2. Remove the four Allen screws from the left side panel, using a  
3 mm Allen wrench, and remove the panel. 

3. A diagram of the hydraulic tubing for the DSX™ Automated 
ELISA System is shown in Figure 38. Consult the diagram for 
routing of the tubing. 

4. Replace the tubing and fittings as required. 

5. Replace the side panel and secure it using the Allen screws. 

6. Close the front panel. 

Side 
Panel 
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Figure 38.  Hydraulic Tubing Diagram 
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Cleaning the Wash Head  

! CAUTION: Always disconnect the power before 
servicing the system.  

 

To remove the wash head assembly: 

1. Grasp the wash head assembly and lift it up from the retaining 
cradle. 

2. Lift the wash head and tubing clear of the instrument. If 
necessary, remove the wash tubing and waste tubing from the 
retainer clips at the front of the instrument. 

To clean the wash head assembly: 

1. Pass the Cleaning Wire through the inside of each wash pin and 
waste pin on the wash head. 

2. Run a PURGE to rinse any material from the wash pins.  

To replace the wash head assembly: 

1. Position the wash head assembly back in the retaining cradle. 

2. If necessary, replace the wash tubing and waste tubing into the 
retainer clips at the front of the instrument.  
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Chapter 9  Service 

Returning a Module for Service 

If the instrument must be returned for service, it must be cleaned and 
decontaminated if it has been in contact with potentially infectious body 
fluids (including human blood), pathological samples, or toxic or radioactive 
materials. 

! Warning: While the DSX alone does not present a 
biohazard, the samples that are used and all parts 
and consumables in contact with the samples must 
be considered biohazardous. 

! Note: Refer to page 67 for cleaning and 
decontamination instructions.  

To return a module for service: 

! Note: Refer to page 68 for module removal 
instructions.  

1. Contact the nearest DYNEX technical service facility for return 
authorization. 

2. Clean and decontaminate the module. 

3. Fill out an Equipment in Transit form (Figure 39). 

4. Pack the module and the Equipment in Transit form for 
shipment. 

5. After you receive a return authorization, ship the module to the 
nearest DYNEX facility (see page 78).  
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Figure 39.  Equipment in Transit Form  
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Limited Warranty 

Warranty and Special Provisions 

DYNEX TECHNOLOGIES, INC. products are fully guaranteed for one year against 
defects in parts, materials, and workmanship.  Defective parts and materials will be 
replaced or, at the discretion of DYNEX, repaired at no charge for a period of one 
year and labor required for such replacement or repair will be provided at no charge 
for a period of one year, provided that the products are utilized and maintained in 
accordance with the instructions in the applicable operating and servicing manual, 
and provided further that the products have not, as determined solely by DYNEX, 
been subject to misuse or abuse by the Customer or other parties unrelated to 
DYNEX.  DYNEX makes no warranty, expressed or implied, as to the fitness of any 
product for any particular purposes other than those purposes described in the 
applicable operating and servicing manual, nor does DYNEX make any other 
warranty, whether expressed or implied, including merchantability, other than those 
appearing on the face hereof.  Where DYNEX guarantees any product, whether 
under this Warranty or as a matter of law, and there is a breach of such guarantee, 
the Customer's only and exclusive remedy shall be the replacement or repair of 
defective parts and materials, as described above.  This shall be the limit of 
DYNEXs liability.  Furthermore, DYNEX shall not be liable for incidental or 
consequential damages.  Failure of the Customer to notify DYNEX of a claimed 
defect by registered mail within thirty days of the discovery thereof shall constitute a 
waiver of any claim for breach of warranty. 

When a product is required by DYNEX to be installed by a DYNEX engineer or 
technician, the period of this Warranty shall begin on the date of such installation, 
provided, however, that any use of the product prior to such installation shall, at the 
sole election of DYNEX. void this Warranty.  When installation by DYNEX personnel 
is not required, the period of this Warranty shall begin on the date of shipment from 
DYNEX.  The period of this Warranty shall begin as described above whether or not 
the product has been installed or shipped pursuant to a purchase order, and any trail 
period shall be deducted from the Warranty period that would otherwise apply under 
a subsequent placed purchase order for that product. 

Limitation of Liability. Notwithstanding anything to the contrary contained herein, the 
liability of SELLER (whether by reason of breach of warranty, breach of contract, 
tort, or otherwise), including without limitation under any indemnification provision 
contained herein, shall be limited to replacement of goods returned to DYNEX which 
are shown to DYNEX ’s reasonable satisfaction to have been nonconforming or to 
refund the purchase price, or, if not paid, to a credit amount of the purchase price 
therefor. 

THE FOREGOING WARRANTIES ARE EXCLUSIVE AND ARE GIVEN 
AND ACCEPTED IN LIEU OF ANY AND ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, THE 
IMPLIED WARRANTY OF MECHANTABILITY AND THE IMPLIED 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE. NEITHER 
PARTY SHALL BE LIABLE TO THE OTHER FOR ANY INCIDENTAL, 
INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES. 
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Sales Offices 

Please contact your nearest sales office for accessories, technical 
assistance or information on product servicing. 

 

Dynex Technologies, Inc. 
Unit 20E, 20th Floor, Centre 600 
82 King Lam Street  
Cheung Sha Wan, Kowloon  
Hong Kong 
China  
Tel: +852 25743389  
Fax: +852 28345217 
E-mail: aua@dynextechnologies.com 
 

Dynex Hybaid Labsystems 
Berner Strasse 53 
60437 Frankfurt am Main 
Germany 
Tel: +49 (0) 69/50919680 
Fax: +49 (0) 69/50919698 
E-mail: labsystems.de@thermobio.com 
 

Dynex Hybaid Labsystems 
Na Cihadle, 32  
160 00 Praha 6  
Czech Republic  
Tel: +420 2 24 31 33 75 
Fax: +420 2 24 32 01 33 
E-mail: office@dynex.cz  
 

Dynex Labsystems 
Action Court 
Ashford Road 
Middlesex TW15 1XB 
U.K. 
Tel: +44 (0) 1784 251 225  
Fax: +44 (0) 1784 258 739 
E-mail: o.sales@dynex.co.uk 

 
Labsystems Oy 
Sorvaajankatu 15 
00810 Helsinki 
Finland 
Tel: 358-9-329-100 
Fax: 358-9-3291-0312 
 

 
Dynex Technologies, Inc. 
14340 Sullyfield Circle 
Chantilly, VA 20151 
USA 
Tel: +1 703-631-7800 
Toll Free: 800-336-4543 
Fax: +1 703-631-7816 
E-mail: info@dynextechnologies.com 

Dynex Hybaid Labsystems 
Eragny Parc - BP 249 
95615 Cergy Pontoise Cedex 
France 
Tel: +33 1 34 32 51 51 
Fax: +33 1 34 32 51 59 
E-mail: 
labsystems.france@thermobio.com 
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Index 

absorbance, 24, 25 
accessories 

dilution plate, 8 
liquid waste container, 20 
standard/control rack, 1 
wash buffer containers, 18 
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ASPIRATE, 17 
aspiration height, 16 
assay definition, 29 
blanking, 25 
checksum, 41 
cleaning, 67 
configuration options, 27 
consumables, 54 

sample tips, 2 
data bits, 34 
decontamination, 67 
dilution 

protocols, 13 
Dimensions, 33 
DISPENSE, 17 
dispense height, 16 
DSX 

description, 5 
illustration, 5 

DYNEX facilities, 80 
FILL, 17 
Filters 

Dual Mode, 24 
installing, 71 
Multiple Mode, 25, 33 
reference filter, 25 
Single Mode, 33 
test filter, 24 

footprint, 38 
handshake, 40 
lamp, 23, 68, 69, 70 
maintenance 

daily, 65 
six-month, 65 
weekly, 65 

microplates 
deep well, 13 

MOVE, 17 

Operations menu, 29 
parity, 34 
password, 53 
pipette module, 11 
pipetting 

profiles, 12 
plate drawer, 18 
positioning, 38 
power ON, 44 
Purge, 18 
PURGE, 17 
return of a module, 77 
RS232, 34, 39 
self-tests, 46 
SOAK, 17 
stop bits, 34 
sweep height, 16 
test filter, 24 
tubing, 73 

wash, 55 
unpacking, 38 
Unpacking, 37 
UPS, 44 
usage area, 38 
warning labels, 35 
Wash Container 

cleaning, 55, 62 
installing, 55 
refilling, 55, 62 

wash head 
cleaning, 75 
positions, 16 
replacement, 75 
wash pins, 15 

wash module, 15 
wash pins, 15 
wash protocol 

operations, 17 
waste, 20 
Waste Container 

cleaning, 62 
emptying, 62 

wavelength, 24, 25, 33 
well top, 16 
worklist, 31, 59, 60, 61 
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